Webcam video capture and streaming tool

VCapStream Ver.1.01
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1 Overview
This software provides the following features:
®  Capture and display images from a web camera connected to a PC.
Save the captured video and audio to a file.
Play the saved video file.

Transfer live images captured from a webcam to this app running on another PC.

Receive and display live images transferred from this app running on another PC.

2 Operating environment
Windows 10, Windows 11

3 Tools used
This software uses the following NuGet packages to implement functions for capturing and playing camera images,
capturing and playing audio, and saving and playing video files.
. Accord.Video.DirectShow (Accord. NET-Framework) By: Accord. NET
Used for capturing images from a camera, obtaining camera information, and setting camera settings.
. Accord.Video.FFMPEG (Accord. NET-Framework) By: Accord. NET
Used for saving and playing video files.
The license terms for Accord. NET-Framework are described in Accord.NET-Framework-license.txt in the
installation folder.
*  Naudio By: Mark Heath & Contributors
Used for audio input from a microphone, audio output to speakers, and saving and playing audio files.
The NAudio license terms are described in NAudio-license.txt in the installation folder.
. FFmpeg (Used as an external program if installed)
Used to combine audio (wav) and video (mp4) files when saving a video, and to separate audio files from video

files when playing a video.

4 File structure

When you unzip the archive, the following files will be generated:

setup.exe setup program
VcapStream_Setup.msi installer
5 Install

5.1 Installation of the Software
This software uses .NET Framework 4.7.2, so the necessary files will be downloaded from the .NET Framework
download site during installation.
Therefore, when installing, please make sure you are in an environment with an internet connection and run setup.exe

beforehand.



This does not apply if NET Framework 4.7.2 is already installed.
After unzipping the software archive and running setup.exe, the setup wizard screen shown below will appear. Follow

the on-screen instructions to proceed with the installation.
P

Welcome to the VCapStream Setup Wizard

The installer will guide you through the steps required to install ¥CapStream on pour computer.

WARMIMG: Thiz computer pragram is protected by copyright law and international breaties.
Unautharized duplication or distribution of thiz program, or any portian of it, may result in severe civil
or criminal penaltizz, and will be progecuted to the maximum extent pozzible under the law.

< Back Memst = Cancel

When you press the "Next" button in the image above, the "Select Installation Folder" screen shown below will appear.
5|

Select Installation Folder

The ingtaller will install YCapStream to the following folder.

To ingtall in thiz folder, click "Nest". Toinstall to a different falder, enter it below or click "Browse".

Folder:
C¥Program Files (x86¥GUSUKU$WCapStreams Brawse.. .
Digk Cost...
Ihstall Wi apStream far voursel, ar for anvone whao uzes this computar:
© Evenone
() Just me
< Back l Mest » Cancel

Once you have selected the installation folder and target users, click the "Next" button to proceed.



When you proceed, the following screen will appear, so click the "Next" button to proceed.

5 |

Confirm Installation

The ingtaller iz ready to ingtall YCapStream on your computer.

Click "Mext'" to start the installation.

< Back Mest » ] Cancel

When the installation is complete, the following screen will be displayed. Click the "Close" button to finish.

5 |

Installation Complete

WLapStream has been successfully installed.

Click "Cloge'" to exit.

Pleaze use Windows Update to check for any crtical updates to the MET Framewark.

< Back Cloze ] Cancel



A VCapStream shortcut will be created on your desktop as shown below.

g

WCapStream

When registering to the Start menu, a VCapStream shortcut may be placed in All Programs, or a folder called

GUSUKU may be created and a VCapStream shortcut may be placed in it.

- GUSUKU =
New

L——E] Help_en.pdf
f_i::] Help_ja.pdf
f_}'—j Readme_en.txt

Readme_ja.txt

’
ng VCapStream
B ew
M

Help files are available in Japanese and English as PDF files.

Help_en.pdf English help file
Help_ja.pdf Japanese help file
A brief program description is provided in the Readme file below.
Readme_en.txt English version
Readme_ja.txt Japanese version

5.2  Installing Ffmpeg
FFmpeg is not included in this program's installer.

To install FFmpeg, open a command prompt as an administrator and run the following command:
winget install --id=Gyan.FFmpeg -e

You must be connected to the Internet when running the above command.



6 Uninstall
Open the Control Panel and select "Uninstall a Program" if you are viewing by Category, or "Programs and Features"
if you are viewing by Large or Small icons.

Select VCapStream from the "Uninstall or change a program" list on the Programs and Features screen and uninstall

it.
g P - ]
<« v EFl > Control Panel > Programs > Programs and Features ~ G Search Programs and Featu... Q@
Control Panel Home .
Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
®y Turn Windows features on or
off Organize *  Change =~ 0
MName - Publisher Installed On  Size Version
B (L Microsoft Edge Microsoft Corporation 1/11/2026 143.0.3650.139
Microsoft OneDrive Microsoft Corporation 1/12/2026 200MB 22,012.0117.0003
[®] Microsoft Update Health Tools Microsoft Corporation 1/13/2026 1.02MB  5.72.0.0
‘_'@Microsof‘t\u‘isual C++ 2015-2022 Redistributable (x64) - 14.40.3... Microsoft Corporation 1/13/2026 20,7 MB 14.40.33816.0
‘_'@Microsof‘t\u‘isual C++ 2013-2022 Bedist = icrosoft Corporation 1/13/2026 181 MB  14.40.33816.0
emote Desktop Connection Microsoft Corporation 7
& VCapStream GUSUKU 1/13/20; 437MB 100
S 4 1/12/2026 131MB 13010

Microsoft Corporation Product version:  143.0.3650.139

7 How to start
Select VCapStream from the All menu in the Windows Start menu and start it.
If you cannot find VCapStream in the Start menu, it may be in a group called GUSUKU. In that case, launch
VCapStream in GUSUKU.



8 Connection Diagram

This application has the function of connecting to a webcam, capturing and displaying camera images, and also the function

of starting a server function while capturing camera images, and streaming the captured images if a client connects.

The image below shows the connection when capturing and streaming camera images.

Camera & Microphone
or
Video File

Server PC1
IP address : 192.168.1.100

A 4

This Application
Connects to: Camera and
microphone
Listen Port : 8080
Start the capture and
start the server

The screen will play the
camera image and
microphone audio,

or the video file image
and audio.

Transferring images
and audio via TCP/IP
communication

Client & Server PC2
IP address : 192.168.1.101

communication
y

Client PC1

This Application
Connects to: Server PC1
Host: 192.168.1.100
Port: 8080

Plays back images
and audio received
from server PC1.

Transferring images
and audio via TCP/IP

This Application
Connects to: Server PC1
Host:192.168.1.100

Port: 8080
Server settings:
Listen Port : 8080
Start the capture and
Start the server

Plays back images
and audio received
from server PCI1.

Transferring images

and audio via TCP/IP
communication

A 4

Client PC3

This Application
Connects to: Server PC2
Host: 192.168.1.101
Port: 8080
Plays back images

and audio received
from server PC1.

The server accepts connections from multiple clients, making it possible for connections like those shown in the diagram

above for Server PC1.

A client can connect to a server and become a server at the same time, so it can relay images received from the server and

send them to another client.



9 Screen Description

When you start VCapStream, the screen below will appear.

File  View Tool Help
[ B ‘}} Yal:

The screen shown above is explained below.

9.1 Title Bar

The title bar displays the application title and version number.

Pressing the " - ", "O", or "x" buttons on the right will perform the actions of "minimize", "maximize", or "exit

application”, respectively.

Click the icon on the left to display the system menu.



fHe VCapStream Ver.1.00

Mowe
Size
= Minimize
O Maximize

¥ Close Alt+F4

We will not explain the functions of the system menu as they are standard for Windows.

9.2 Menu Bar

The menu bar has three menu groups.
File View Tool Help

9.2.1 File menu

The File menu has the following items:

f5 VCapStream Ver.1.01

File | View Tool Help

Connect ...

Open Video File ...

Exit Application

(1). Connect

The Connect dialog shown below will be displayed, allowing you to connect to the camera or server.

Use Audio Input Device

Camera
Camera Device Logi C615 HD WebCam
Frame Size 640480
Frame Rate 15 | fps

Audio Input Device Microphone (Logi C&15 HD WebCam
Audio Sample Rate 16000 ~ | Hz
Server [_|

Cancel




If the "Camera" checkbox is checked, a connection to the camera will be made.

Select the camera to connect to from the "Camera Device" combo box.

Camera B
Camera Device Logi C270 HD WebCam
Logi CZ70 HD WebCam
Frame Size Logi C&15 HD WebCam
Frame Rate 15 > fps

B Use Audio Input Device

Audio Input Device Microphane {Logi C&15 HD WebCam e
Mudio Sample Rate 16000 ~ | Hz

In the example above, when you open the combo box, two cameras are displayed, so you can select the
camera you want to connect from there.

When "Use audio input device" is checked, you can capture audio input from the microphone along with
the image.

When "Use audio input device" is checked, the "Audio input device" combo box will become selectable,
so select the microphone device from there.

B Use Audio Input Device

Audio Input Device Microphone (Logi C615 HD WebCam
Microphone (Logi C615 HD WebCam
Microphaone (High Definttion Aud
Z4 1 (Logi C270 HD WebCam)

Audio Sample Rate

The input audio will also be available in the server function described below, and can be heard at the

destination of the stream.

If you check "Use audio input device", you will also be able to select the "Audio sample rate" combo box.
B Use Audio Input Device

Audio Input Device Microphone (Logi C615 HD WebCam w

Audio Sample Rate 16000 ~| Hz

8000

12000
Server [
24000
28000
anon | 32000
TR 136000
40000
44000
43000 Apply Cancel

The default audio sample rate is 16000 Hz, but if you select a value higher than that, the streaming audio
may be interrupted.

When the "Server" checkbox is checked, it will connect to a VCapStream running on another PC.



).

).

(4).

Server [
Host 192.168.1.26

Part a0an

In the example above, we will connect to VCapStream, which is running as a server on the PC with the IP
address specified in "Host".

VCapStream running on the PC specified in "Host" must be connected to the camera and "Start Server"
must be selected from the "Tools" menu.

The port number in the "Connection" dialog must match the port number for "Listen TCP Port" in the
"Option Settings" dialog opened from the server's "Tools" menu.

The server's port number is specified in the "Option Settings" dialog opened from the "Tools" menu.

The connection destination of the server-side VCapStream can be another VCapStream server.
Disconnect

Disconnects from the connected camera or VCapStream server.

Open Video File

To play the recorded video file, open the video file (MPEGH4 file) in the file selection dialog.

< v » PC » la-f (D) » Data v O Dataltes o
EE - FLLTAIS- =~- O @
Data | & $4% 2 &8 £z

DXSDK |©] capture-20251002-122637.mp4 6,568 KB P4 J7A Il
Home |©] capture-20251009-194258.mp4 T3KB pa 374 )l
Program Files |0] capture-20251009-184612.mp4 145 KB P4 J7A Il
Project |@] capture-20251002-124253. mp4 018 KB Pa J7A Jls
pub
TRANEN): | | MPEGA file(*.mpa) v
8o |v Foull

If you did not use FFmpeg to combine and save the video and audio during recording, the video data (mp4)
and audio data (wav) will be saved as separate files with different extensions.

Therefore, if there is a file with the same name as the video file but a wav extension, you will be asked if
you want to use it as the audio data. Selecting OK will allow you to play the video with audio.

If there is no wav file with the same name as the video file, and FFmpeg is installed, an attempt will be
made to extract the audio data from the video file and play it.

If the video file does not contain audio data, it will play without audio.

Close Video File

Closes an open video file.

(5). Exit Application



Quit the application.
9.2.2 View Menu

The "View" menu has the following items:

File Tool Help
> Mirrcr ’
Flip Up/Down

Fit Window to Image

Camera Property ...

(1). Mirror
Reverses the image horizontally.
(2). Flip Up/Down
Flips the image upside down.
(3). Fit Window to Image
Resize the window to fit the image size.
(4). Video Property

Displays the properties dialog for the connected camera.

The properties dialog will vary depending on the camera, below is an example for the Logitech C270 HD
WebCam.

i Video Proc Amp  Camera Control

Auto
| Brightness I 178

Confrast 1 37
Hue

Saturation 1 32

Sharpness 1 24
3amma

White Balance 4980 -]
Backlight Comp |
Gain | 56
ColorEnable Puwerle?[ :;?jq:ﬁjr:g}
Default

QK Cancel Apply



9.2.3 Tool menu

The Tool menu has the following items:

i3 VCapStream Ver.1.01

File  View

> =

Help

Capture Start (]
Capture Stop
Server Start
Server Stop
Video Play
Video Pause
Video Rewind
Options...
Video Setting ...

(1). Capture Start
Starts capturing video from a camera or server.
(2). Capture Stop
Stops capturing video from the camera or server.
(3). Server Start
Start the video streaming server.
(4). Server Store
Stop the video streaming server.
(5). Video Play
Starts playing the opened video file.
(6). Video Pause
Stops playing an open video file.
(7). Video Rewind
Returns the playback position to the beginning of the opened video file.
(8). Options
The option setting dialog shown below will be displayed.



File

Yideo Save Dir:

Sound

Sound devices:

A —h— (USE Speaker)

D% Data Ref ..

Yideo Filename: capture =y MMdd-HHmmss mpd

Audio File: B !Use FFmpeeexe to combine audio and wideo files

* Available if FFmpee iz installed.

Max Fecord Frames I Frames # Specify [ for no limit

Snapzhaot Save Dir: D¥Data Ref ..
Snapzhot Filename: znapshot =y idd-HHmmzz jpe

Server Setting

Listen TGP Port aoao

fpoply

Cancel

In the option settings dialog, set the following items.

® [File] group

1. Video Save Dir.

Set the directory (folder) where you want to save the video files.

[Ref ... ] button, the folder selection dialog shown below will be displayed.

desired folder by opening it and pressing the Open button.

T~ > PC » MUz-f(Dx) > Data

FLLWIANS-

Config.Msi

ap

1

Data
DXSDK
Home

Dr~mrama Eilar

You can select the

o @

i

F74 A (N |SelectFoIder

e

Folder (.)

= (8] Foutll

2. Video Filename

Set the file name when saving the video file.

The date and time will be added to the end of the file name you set for the saved file.

3.Audio File

If FFmpeg is installed, this option determines whether to merge audio files into video files.

If you check "Use Ffmpeg.exe to combine audio and video files", the audio data will be combined



with the video file to create a single video file (mp4) with audio.
If this checkbox is not checked, or if it is checked but FFmpeg is not installed, the video file and
audio file will be saved as separate files.
In that case, the file names will be the same, but the video file will have the mp4 extension and the
audio file will have the wav extension.
. Max Record Frames
Sets the maximum number of frames for a video file to be saved.
Recording will stop automatically when the specified number of frames is reached.
If the setting value is 0, recording will be performed without frame limit.
. Snapshot Save Dir.
Set the directory where snapshot images are saved for capture images.
[Ref ... ] button, the folder selection dialog shown below will be displayed. You can select the

desired folder by opening it and pressing the Open button.

o v > PC » filla-L(Dx) » Data ~ 3 | | Datal DiEE el
B2E - HLWIANA- =~ 1O @
BootLoaderTaol A - HAx EHAE 5
Config.Msi o o _
EEEZFIL—ETIEEEREVIEN
Data | |
DXSDK
JrAIbE(N): |SelectFoIder ~ | Folder (.) ~
B0 Foull

. Snapshot Filename
Set the file name for saving the snapshot image of the captured image.
The date and time will be added to the end of the file name you set for the saved file.
[Server Setting] group
1. Listen TCP Port
Specify the server's listening port number.

[Sound] Group

1. Sound Device

Select the speaker device for audio output from the combo box.

Sound
Sound devices: AP —h— (USE Speaker)

2 —— (UUSE Speaker)

2

Ex-LDH241DBCE Fo ':N‘-.-"IDIF\ High De ancel
Realtek Digital Qutput {Realtek

EX-LD238 10035 E) (NVIDIA High Def

Ex-LD238 100 ) (NVIDIA High Def

E}{—LDHEHDB(E—F} (HWIDIA High De




The combo box displays the currently connected speakers.
(9). Video Settings
Open the Video Options dialog shown below.

YWiden
Frame Size |ﬁ-m % 480 v|

Frame Rate 15 | fp=

Apply Cancel

In the Video Option dialog, set the following items:
® [Video] Group
1. Frame Size
Sets the size of the image captured by the camera.

Wideo

Frame Size

Frame Rate 160 = 120

176 = 144
320 = 176
320 = 240
362 = 288
432« 240
add x 288

FAN - RN
2. Video Filename

Set the frame rate for video captured by the camera.

Frame Rate 15) w | fps

Cancel

if.ﬂﬂ:l'\-\.lmu'l

T P S BT —|




9.3 Control Area

The control area contains controls for capturing and playing video files.

- 0 & @ ‘}} Yal:

The control area becomes operational when you connect to a camera or VCapStream server or open a video file.

>m & @ 4}}@: ]

The control area contains the following controls:
(1). [Start] button

Starts capturing from a camera or playing a video file.

>

(2). [Stop] button

Stops capturing from the camera or playing a video file.

(3). [Snapshot] button

Saves a snapshot image of the video being captured from the camera or server in JPEG format.
(@]
(4). [Record] button

Turn on the "Record" button and then press the "Start" button to save the captured image to a video file.

b (OFF state)

When the "Record" button is on, the background color will turn orange.

E] (ON state)

The video file will be saved in the folder you specified in the options settings.
(5). [Sound] button
Switches the audio playback on the speaker ON/OFF.

¢

When the "Sound" button is ON, the background color will turn orange.

(ON state)

(OFF state)



(6). Audio volume adjustment trackbar

Adjust the volume of the audio being played.

|‘-.-f.:.|: [ |

(7). Video playback position change track bar
Change the playback position when playing a video.
Drag the knob or click the mouse button on the track bar to move the playback position of the open video file.

| B

9.4  Display Area

It displays captured images from the camera, received images from the server, and playback images of video files.

8% VCapStream Ver.1.01 — O
File View Tool Help

> (@ e ¢ o a




The image above shows the screen while an image is being captured from the camera.

If you change the window size, the image size in the display area will be enlarged or reduced to fit the window size.

9.5 Status bar

The status bar displays various information.

| 00:00:23.125 | YT R

/

Image size Elapsed time
Frame rate Frame Counter

The information displayed in the above image is explained below.
(1). Image size

Displays the pixel size of the captured image or video file in width x height format.
(2). Frame rate

Displays the frame rate of the captured image or video in fps (frames per second).
(3). Elapsed time

The time elapsed since the start of capture or playback

(4). Frame Counter
When capturing, the number of frames captured from the start is displayed.

When playing a video file, the current frame position and total number of frames are displayed.



10 Streaming Formats
Video and audio are transmitted over a single TCP/IP port.
10.1 Streaming Sequences
The sequence for connecting from the client to the server and sending video and audio from the server to the
client is as follows:

(The <CR><LF> below represent the line break codes 0x0d and 0x0a in hexadecimal.)

( Server ) ( Client )

TCP connection from client to server

Sending from the client
GET<CR><LF>

Response from the server (streaming header)
HTTP/1.1 200 OK<CR><LF>
Content-Type: multipert/x-mixed-replace:boundary=—boundary;
audio_boundary=--audio_boundary;
image size=640x480; audio_sample rate=1600<CR><LF>

\4

~ Receiving Send from server (image header)
images from a <CR><LF>--boundary<CR><LF>
camera Or server Content-Type: image/jpeg<CR><LF>

Content-Bcee: B5; Content-Length: 63291 <CR><LF><CR><LF>

\4

Transmission from the server (image data)
(JPEG format binary data of the size indicated in Content-Length)

A\

Sending from the server (image data end)

<CR><LF>
Receive audio ;
_ from a Sent from the server (audio header) Image
microphone or <CR><LF>--audio_boundary<CR><LF> playback
Server Content-Type: audio/raw<CR><LF>

I Content-Bcc: 5D; Content-Length: 3200<CR><LF><CR><LF>

A\

Transmission from the server (audio data)
(16-bit mono binary data of the size specified in Content-Length)

A\

Sending from the server (audio data end)
<CR><LF>

A\

v

Audio
playback

Sends from the server until stopped or disconnected
(The order of image data and audio data is not fixed.)

>

10.2 Incoming requests from clients

When a client connects to a server, it sends the following receive request to the server and waits for a response:

GET<CR><LF>



10.3 Streaming Headers
Upon receiving an incoming request from a client, the server sends the following message to the client:
*When audio data is included, image size is 640x480, and audio sample rate is 16000Hz.

(The second line is wrapped for page convenience, but it is actually one line.)

HTTP/1.1 200 OK<CR><LF>

Content-Type: multipert/x-mixed-replace; boundary=--boundary; audio_boundary=--audio_boundary;

image size=640x480; audio_sample rate=16000<CR><LF>

*When the image size is 640x480 without audio data
(The second line is wrapped for page size, but it is actually one line.)

HTTP/1.1 200 OK<CR><LF>

Content-Type: multipert/x-mixed-replace; boundary=--boundary; audio_boundary=--audio_boundary;
image size=640x480<CR><LF>

10.4 Image Data

When the server receives an image from a camera or another server, it sends the image data in the following

format:

<CR><LF>

--boundary<CR><LF>

Content-Type: image/jpeg<CR><LF>

Content-Bcec: F5; Content-Length: 63291<CR><LF>
<CR><LF>

Image data (jpeg format data of the size specified by Content-Length is sent in binary format)
<CR><LF>

The image data checksum is the F5 part of Content-Bcc: F5, which is the value obtained by XORing the image
data byte by byte from the beginning to the end.

When the client receives the —boundary line, it determines that this is the start of the image data and continues
to receive the data that follows in order. After receiving the image data length and checksum, it imports the image

data after the blank line, calculates the checksum, and if they match, converts the image data into an image and

imports it.

If the checksum calculation does not match, it is discarded.



10.5 Audio Data

When the server receives audio data from a microphone or another server, it sends the audio data in the following

format:

<CR><LF>

--audio_boundary<CR><LF>

Content-Type: audio/raw<CR><LF>

Content-Bcec: B4; Content-Length: 3200<CR><LF>

<CR><LF>

Audio data (16-bit audio data of the size specified by Content-Length is sent in binary format)
<CR><LF>

The audio data checksum is the B4 part of Content-Bcc: B4, which is the value obtained by XORing the audio
data byte by byte from the beginning to the end.

When the client receives the --audio_boundary line, it determines that this is the start of audio data and receives
the data that follows in order. After receiving the audio data length and checksum, it takes in the audio data after

the blank line, calculates the checksum, and if it matches, takes in the audio data.

If the checksum calculation does not match, it discards it as noise.



11 Configuration file(VCapStream.ini)
A settings file named VCapStream.ini is automatically generated.
The VCapStream.ini file attempts to save it in the folder where the application is installed, but if the application is
installed in a system-protected folder such as "C:¥Program Files" or "C:¥Program Files (x86)", the file cannot be written
to by the application, so VCapStream.ini is saved in the application settings folder.

In most cases, it is created in the folder indicated by the following path:

* C:¥ProgramData¥GUSUKU¥VCapStream

The items in VCapStream.ini are explained below.

[SETTING] Settings section

CONNECT_TYPE=0 Destination 0=Camera 1=Server
CAMERA NAME=Logi C270 HD WebCam The name of the last connected camera
FRAME WIDTH=640 Frame size (width)

FRAME HEIGHT=480 Frame size (vertical)

FRAME RATE=15 frame rate (fps)
AUDIO_INPUT_ENABLE=True Microphone input availability

(True=yes, False=no)

AUDIO_INPUT _NAME=Microphone (Logi C270 HD WebCam) Microphone device name

AUDIO_SAMPLE RATE=16000 Audio sampling rate

SERVER NAME=192.168.1.26 The host name/IP address of the last connected
server

SERVER PORT=8080 TCP port number of the last connected server

VIDEO_DIR=D:¥Data Path to the folder where video files are saved

VIDE FILE NAME = Capture video file name

REC_FRAME COUNT=0 Maximum number of frames to save

(0 =no limit)

SNAPSHOT DIR=D:¥Data Path to the snapshot storage folder

SNAPSHOT FILE NAME=snapshot Snapshot save file name

LISTEN_PORT=8080 TCP port number to listen on when the server
is running

AUDIO_OUTPUT_NAME=Speaker (USB Speaker) Audio output (speaker) device name



12 [Update history]

Ver.1.00 2026/01/13
*Initial Release

Ver.1.01 2026/01/31
*Added a checksum to the transferred data.
- If FFmpeg is installed, it will launch ffmpeg as an external program to combine the audio and video and

save them into a single file.

*Fixed a bug where audio from the server could not be saved to the video file.
* Added audio input sample rate setting.

* Added streaming header items (image size, audio sample rate, etc.).

13 [Acknowledgments]
We would like to thank the following people who provided us with the NuGet packages used in this program.
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* Accord.Video.FFMPEG Created by: Accord. NET
Used for saving and playing video files.
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14 [Terms of use]
* Terms of use
There are no special conditions. Please use it freely.
However, this does not include use for criminal purposes or harming others.
* Distribution
Redistribution is free in unedited or unmodified form.
+ Editing and modification (for source code)
Modifications and changes are free, but if you redistribute a modified version, you must include documentation clearly
stating the changes in the distribution.
This does not apply if part of this software's source code is used in other software.
*Disclaimer
The author assumes no responsibility for any damage or injury resulting from the use of this software.
The author assumes no obligation to fix or upgrade the software, even if bugs are discovered.
*Bugs and requests
Please report any bugs or requests via email.
However, there is no guarantee that bugs will be fixed or requests will be implemented.
* Copyright information:
The copyright of this software is held by the author, GUSUKU.
This software is protected by Japanese Copyright Act and international treaties.
Use within the scope of the Terms of Use is permitted, but please note that use or distribution in violation of the Terms

of Use will constitute copyright infringement.

+ Copyright information of the package used
This software uses the following NuGet packages.
Copyright information for each package is provided in the license information for each package.
* Accord NET Framework ( Accord , Accord.Video , Accord.Video.DirectShow , Accord.Video.FFMPEG )
The license information for this package is available in Accord. NET-Framework-license.txt.
*Naudio
The license information for this package is available in NAudio-license.txt.

15 [contact address]
GUSUKU
root@gusuku.org
[Website]
https://www.gusuku.org/
[Software release site]

https://www.gusuku.org/software
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